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Колоректальний рак (КРР) вважається маркером соціально-економічного розвитку, оскільки в економіці країн пе-
рехідного періоду рівень захворюваності на КРР має тенденцію до рівномірного зростання. Змінення способу життя 
збільшило захворюваність на КРР в останні десятиліття, а саме дієта з підвищеним споживанням продуктів тварин-
ного походження та більш малорухливий спосіб життя призводить до зниження фізичної активності та збільшення 
поширеності надмірної маси тіла (метаболічного синдрому), що також стає все більш актуальною проблемою для 
України. Внутрішньопухлинна васкуляризація та проліферація розглядаються багатьма дослідниками як незалеж-
ний прогностичний фактор перебігу раку. Одним із практичних способів спостереження за ангіогенезом є дослі-
дження гістологічних зрізів пухлин, де імуногістохімічним фарбуванням маркерами CD31 або CD34 виділяється 
ендотелій судин. Дослідження спрямовано на оцінювання внутрішньопухлинної васкуляризації та проліферації клі-
тин колоректальних карцином за допомогою платформи Фіджі. Середня кількість CD-34-позитивних судин виявила 
достовірну різницю у вікових групах (зі збільшенням віку кількість судин зростала, p<0,05); за гістологічним типом 
(найменша кількість судин виявлена в аденокарциномі аденомоподібного типу, найбільша – у мікропапілярній аде-
нокарциномі, р<0,05); за ступенем (у групі G2 кількість судин вірогідно більша, p<0,05); а також у групі з метастаза-
ми кількість судин була достовірно вищою порівняно з групою без метастазів, р<0,05. 

Середня площа CD-34-позитивних судин показала вірогідну різницю у вікових групах (із збільшенням віку площа 
судин збільшувалася, p<0,05); за гістологічним типом (найменша площа судин виявлена при аденокарциномі аде-
номоподібного типу, найбільша – при медулярній аденокарциномі, р<0,05); а також у групі з G3 площа кровонос-
них судин була достовірно більшою (p<0,05). Середній периметр CD-34-позитивних судин достовірно відрізнявся 
лише за гістологічним типом (найменший периметр судин у аденокарциноми аденомоподібного типу, найбільший –      
у мікропапілярної аденокарциноми, р<0,05). Індекс проліферації зростав разом із середньою кількістю та серед-
ньою площею CD-34-позитивних судин (усі р<0,05).
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Background. Colorectal cancer (CRC) is considered a marker of socio-economic development, due to the fact that in 
countries experiencing a transition period in the economy, the incidence rate of CRC has a tendency to increase uniformly. 
Lifestyle changes have increased the incidence of CRC in recent decades, namely, a diet with increased consumption of 
animal products and a more sedentary lifestyle leads to a decrease in physical activity and an increase in the prevalence 
of excess body weight (metabolic syndrome), which also becomes increasingly urgent problem for Ukraine. Intratumoral 
vascularization and proliferation are considered by many researchers as an independent prognostic factor during cancer. 
One of the practical ways of observing angiogenesis is the study of histological sections of tumors, where the endothelium 
of vessels is distinguished by immunohistochemical staining with markers CD31 or CD34. The aim of the study was to 
evaluate intratumoral vascularization and cell proliferation in colorectal carcinomas using the Fiji platform.

Material and methods. The work examined the clinical and anatomical material of CRC of 37 patients (15 women and 22 
men), which was obtained during operations (right hemicolectomy, resection of the sigmoid colon, Hartmann’s operation, 
resection of the transverse colon, resection of the ileum); all of them were treated in the 2nd surgical department of the 
Dnipropetrovsk Regional Clinical Hospital in the period from 2019 to 2021. The age of the patients ranged from 27 to 82 
years; the average age was 61.43±14.90 years.

Results. The average number of CD-34-positive vessels showed a significant difference in age groups (with increasing 
age, the number of vessels increased, p<0.05); by histological type (the smallest number of vessels was found in adeno-
carcinoma of the adenoma-like type, the largest in micropapillary adenocarcinoma, p<0.05); by grade (in group G2, the 
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number of vessels was significantly higher, p<0.05); and also in the group with metastases, the number of vessels was 
significantly higher compared to the group without metastases, p<0.05.

The average area of CD-34-positive vessels showed a significant difference in age groups (with increasing age, the 
area of vessels increased, p<0.05); by histological type (the smallest area of vessels was found in adenocarcinoma of the 
adenoma-like type, the largest in medullary adenocarcinoma, p<0.05); and also, in the group with G3, the area of blood 
vessels was significantly larger (p<0.05).

Conclusions. The average perimeter of CD-34-positive vessels showed a significant difference only by histological type 
(the smallest perimeter of vessels was found in adenocarcinoma of the adenoma-like type, the largest in micropapillary 
adenocarcinoma, p<0.05).

The proliferation index increased along with the average number and average area of CD-34-positive vessels (all p<0.05).

Keywords: colorectal cancer, tumor vascularization, digital pathology, CD-34, Ki-67.

Вступ. За оцінками International Agency for 
Research on Cancer у 2020 році виявили понад 1,88 
мільйона нових випадків колоректального раку та 
915 880 смертей від нього, що для чоловіків посіло 
3 місце за показником захворюваності та 2 місце 
за показником смертності, а для жінок 3 місце 
за обома показниками серед усіх онкологічних 
захворювань [1]. КРК вважають маркером соці-
ально-економічного розвитку, оскільки в країнах, 
що переживають перехідний період в економіці, 
рівень захворюваності на КРК має тенденцію до 
рівномірного зростання [2, 3]. Зміна способу жит-
тя підвищила захворюваність на КРК за останні 
десятиріччя, а саме, дієта із збільшенням спожи-
вання продуктів тваринного походження та мало-
рухливий спосіб життя призводять до зниження 
фізичної активності та збільшення поширеності 
надлишкової маси тіла (метаболічний синдром) [4, 
5], що також стає все більш актуальною проблемою 
для України. За оцінками Національного канцер-
реєстру України на 2020 рік рак ободової кишки 
продемонстрував 7883 нових випадків і 4299 смер-
тей, а рак прямої кишки – 6572 нових випадків і 
3637 смертей. Отже, за показником захворюваності 
рак ободової і прямої кишки для чоловіків посів 5 
і 7 місце в, а за показником смертності 3 і 5 місце; 
для жінок за показником захворюваності – 5 і 8 
місце, а за показником смертності – 3 і 6 місце 
відповідно [6].

Внутрішньо-пухлинна васкуляризація та про-
ліферація багатьма дослідниками розглядаються 
як незалежний прогностичний фактор перебігу 
онкозахворювань [7-11]. Одним із практичних спо-
собів спостереження за ангіогенезом є дослідження 
гістологічних зрізів пухлин, де ендотелій судин ви-
діляють шляхом імуногістохімічного фарбування 
маркерами CD31 або CD34 [11]. Розподіл судин, 
кількість та площа їх розповсюдження об’єднані 
терміном «щільність мікросудин», і як показують 
дослідження відрізняється в різних пухлинах [10-12].

Об’єктивні методи оцінювання гістологічних 
зрізів у медичних дослідженнях включають аналіз 
цифрових зображень, що одержують за допомогою 
камер і світлових або конфокальних мікроскопів. 
Але рішення діагностичних і наукових завдань при 
роботі з візуальною інформацією вимагає знання 
специфічних методів цифрового оброблення й 
аналізу отриманих мікрофотографій. Володіння 
навиками застосування програмного забезпечення 
для аналізу цифрових зображень, нажаль, не вхо-
дить до освітньої програми магістрів та аспірантів 
медичних закладів нашої країни, що у патоморфо-
логів викликає необхідність додаткової самоосвіти 
в цій галузі або колаборації з такими спеціалістами 
немедичного профілю. Одним із зручних інстру-
ментів для аналізу зображень біологічних об’єктів 
являється платформа з відкритим кодом Fiji, що 
розроблена саме для науковців і має доволі зро-
зумілий інтерфейс (розробка ініційована автором 
Wayne Rasband, США). Вмонтовані в Fiji плагіни 
Colour Deconvolution та Immuno Ratio дозволяють 
аналізувати імуногістохімічно забарвлені препара-
ти з отриманням кількісного оцінювання експресії 
маркеру [13-15].

Мета дослідження: оцінити внутрішньопухлин-
ну васкуляризацію і проліферацію клітин колорек-
тальних карцином за допомогою платформи Fiji.

Матеріал і методи дослідження. Досліджено 
клініко-анатомічний матеріал КРК 37 пацієнтів 
(15 жінок і 22 чоловіків), що отримано під час 
оперативних утручань (правобічна геміколектомія, 
резекція сигмоподібної кишки, операція Гартмана, 
резекція поперечно-ободової кишки, резекція клу-
бової кишки). Всі пацієнти проходили лікування 
в 2 хірургічному відділенні Дніпропетровської 
обласної клінічної лікарні імені І. І. Мечникова 
м. Дніпра в період із 2019 по 2021 рр. Вік пацієнтів 
коливався в діапазоні 27-82 роки, середній вік склав 
61,4±14,9 років.
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За гістологічною будовою всі спостереження 
представлені колоректальною карциномою (КРК) 
помірного (31 випадок) і низького (6 випадків) сту-
пеня диференціювання. Гістопатологічні підтипи 
включали: аденокарциному (АК) NOS 19 випадків, 
зубчасту АК 7 випадків, мікропапілярну АК 3 ви-
падки, медулярну АК 3 випадки, муцинозна АК 2 
випадки, перстне-подібноклітинна АК 2 випадки 
та 1 АК типу like-adenoma.

Із них із локалізацією у висхідній частині обо-
дової кишки 5 випадків, у печінковому куті 9 ви-
падків, у поперечно-ободовій кишці 6 випадків, 
у селезінковому куті 1 випадок, у ректо-сигмоїдно-
му сполученні 5 випадків, у сигмоподібній кишці 
10 випадків та у прямій кишці 1 випадок. Отже, 
всі спостереження КРК розділились на правобічні 
КРК (20 випадків) і лівобічні КРК – 17 спосте-
режень. Також весь матеріал розподілено на дві 
групи в залежності від наявності метастазів: без 
метастазів 30 КРК, із метастазами – 7 спостережень 
(6 – у лімфатичних вузлах черевної порожнини та 
1 – в печінці).

Морфологічний метод дослідження. Зразки 
пухлин КРК фіксованих у формаліні та залиті 
парафіном були взяті з архіву КЗ «Дніпровського 
обласного патологоанатомічного бюро». Парафі-
нові зрізи 4-5 мкм отримано на мікротомі Mіcrom 
HM-340 і забарвлено за стандартною методикою 
гематоксиліном та еозином. Два патологоанатома 
незалежно один від одного перевіряли скельця 
на точність діагнозу та наявність артефактів. За 
внутрішній контроль приймали нормальну тка-
нину товстої кишки, що зустрічалась у скельцях 
на границі з пухлинною тканиною. Мікроскопія 
проводилась за допомогою світлового мікроскопу 
«Primo Star» (об’єктиви ×10, ×20, ×40).

Імуногістохімічний метод дослідження. Па-
рафінові зрізи наносили на адгезивні предметні 
скельця SuperFrost Plus. Після депарафінізації, 
регідратації, температурного демаскування анти-
генів і пригнічення активності ендогенної перок-
сидази, проводили інкубацію зрізів із первинними 
антитілами у вологих камерах при температурі 
23-250С протягом 30 хвилин. Використовувалися 
первинні моноклональні антитіла до Ki-67 (sp6, 
1:250), CD34 (sp1, RTU) та система візуалізації 
UltraVision Quanto, LabVision) у вологих камерах 
близько 30 хвилин при кімнатній температурі. Для 
ідентифікації реакції наносився розчин хромогену 
3-діамінобензидин тетрахлориду (ДАБ) (Quanto, 
LabVision) під контролем мікроскопу протягом від 

20 секунд до 3 хвилин, із проявом у вигляді корич-
невого забарвлення, далі додатково забарвлювали 
гематоксиліном Майєра протягом 1-3 хвилини. 
Наступна дегідратація та включення в бальзам 
здійснювалися відповідно до розповсюджених 
методик. 

Для цифрової морфометрії використовували ка-
меру мікроскопу Zeіss Prіmo Star – Axіocam ERC 5s 
із ліцензованим програмним забезпеченням ZEN 2 
blue edіtіon. Сфотографовані поля зору збережено 
в форматі *.jpg і оброблено за допомогою плат-
форми Fiji з визначенням кількості, параметрів 
периметру та площі CD34-позитивних судин із 
метою оцінювання васкуляризації та розрахунком 
відсотків Ki-67-позитивних інтрануклерних реак-
цій плагіном ІmmunoRatіo [13].

Відповідно до рекомендацій Melling N. із спі-
вавт. (2016) для статистичного аналізу результати 
фарбування маркером Ki-67 розподілено на три 
групи (слабка, помірна, висока) за відсотком Ki-
67-позитивних пухлинних клітин: низький Ki-67 
– 0 %-10 %; помірний Ki-67 – 10 %-25 %; високий 
Ki-67 – 25% і більше [8]. 

Статистичний аналіз даних проводили в про-
грамному середовищі R versіon 3.4.1 (2017-06-
30) – «Sіngle Candle» Copyrіght (C) 2017; The 
R Foundatіon for Statіstіcal Computіng Platform: 
x86_64-w64-mіngw32/x64 (64-bіt), що поширюєть-
ся безкоштовно за ліцензією GNU General Publіc 
Lіcense. 

Для порівняння значень показників цифрової 
морфометрії «площа», «периметр», «коефіцієнт 
круглості» судин, а також індексу проліферації 
за маркером Кі-67, розрахованих за допомогою 
плагіну ІmmunoRatіо в платформи Fiji, спочатку за 
допомогою критерію Шапіро-Вілка перевірялась 
відповідність розподілу показника в кожній групі 
на нормальність. У випадку відмінності розпо-
ділу від нормального, для перевірки відмінності 
середніх значень використовувався непараме-
тричний U-критерій Манна-Уітні. Для вибірок із 
нормальним розподілом, для порівняння середніх 
значень використовували t-критерій Стьюдента. 
Встановлення достовірності міжгрупових зв’язків 
за кількісним розподілом проводилось за допо-
могою точного тесту Фішера. Для всіх критеріїв 
відмінності вважали достовірними при р<0,05. 
Дані в таблицях представлені як М±SD (середнє 
значення±стандартне відхилення).

Результати та їх обговорення. Для відокрем-
лення скупчення судин із оточуючих пухлинних 
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Рис. 1. Процедура Colour Deconvolution для 
відокремлення структур забарвлених хромо-ге-
ном DAB у платформи Fiji: Image>Color>Colour 
Deconvolu-ton>Vectors> H&DAB

Рис.  2.  Сегментація в платформи Fij i : 
Image>Adjust> Threshold (із регуляцією порого-
вих значень яскравості для отримання чітких меж 
судин)

Рис. 3. Процес калібрування в платформи Fiji 
з використанням сітки з відомим розміром комір-
ки Analyze>Set Scale> Known distance (90 мкм) > 
Global

Рис. 4. Процес вимірювання параметрів судин 
із збереженням результатів у платформі Fiji: ROI 
Manager>t>Measure>Results> Summarize
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тканин при забарвлені ІГХ методом із маркером 
CD34 у платформи Fiji спочатку використовували 
процедуру Colour Deconvolution, що виділяє тільки 
структури, забарвлені хромогеном DAB (рис. 1). 

Остаточну сегментацію для подальшого розра-
хунку параметрів судин у пухлинній тканині КРК 
проводили через регуляцію порогових значень 
яскравості (вікно Threshold), це дозволяє також 
покращити контрастність об’єктів, якщо їх границі 
нечіткі або незрозумілі (рис. 2).

З метою точного розрахунку параметрів судин у 
пухлинній тканині КРК проводили калібрування 
з використанням фотографії сітки з відомим роз-
міром комірки (90 мкм×90 мкм) – переведення 
пікселей у мікрометри (рис. 3). Далі, використову-
ючи інструмент для вимірювання довжини об’єктів 
неправильної форми, вручну обводили внутрішній 
діаметр зрізу судин, щоб розрахувати їх кількість, 
площу в мкм2 та діаметр у мкм (рис. 4). Для збе-
рігання вимірів використовували ROI Manager. 
Натискання кнопки Measure дає вікно Results із 
значеннями всіх площ і периметрів судин, що 
можна використовувати для розрахунку середньої 
або сумарної площі, середнього периметру судин 
тощо. Для отримання найбільш достовірних даних 
васкуляризації із кожного випадку було проаналі-
зовано три поля зору із збільшенням ×400.

Також у цих ділянках пухлин, як найбільш вас-
куляризованих, було оцінено рівень проліферації 
за маркером Кі-67, що автоматично розраховувався 
плагіном ImmunoRatio (рис. 5).

Розподіл середніх значень кількості, площі та 
периметру судин за клініко-морфологічними ха-
рактеристиками пухлин представлено в табл. 1.

Висновки. 1. Середня кількість CD-34-
позитивних судин показала достовірну різницю 
в групах за віком (із збільшенням віку, кількість 
судин збільшувалась, р<0,05); за гістологічним 
типом (найменша кількість судин виявилась 
в аденокарциномі типу like-аденома, найбільша –     
в  мікропапілярній аденокарциномі, р<0,05); за 
grade (в групі G2 кількість судин було достовірно 
більше, р<0,05); а також у групі з метастазами 
кількість судин була достовірно вищою, порівняно 
з групою без метастазів, р<0,05.

2. Середня площа CD-34-позитивних судин пока-
зала достовірну різницю в групах за віком (із збіль-
шенням віку, площа судин збільшувалась, р<0,05); 
за гістологічним типом (найменша площа судин 
виявилась в аденокарциномі типу like-аденома, 
найбільша – в медулярній аденокарциномі, р<0,05); 
а також у групі з G3 площа судин була достовірно 
більше (р<0,05).

Рис. 5. Автоматичне вимірювання індексу проліферації у платформі Fiji плагіном ImmunoRatio: 
Plugins>ImmunoRatio>nuclear area average
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Таблиця 1
Розподіл середніх значень кількості, площі та периметру судин за клініко-морфологічними  

характеристиками колоректальних карцином

Клініко-морфоло-
гічна характерис-

тика KPK

n (%) n=37 Середня кількість 
CD34-позитивних 

судин (M±SD)

Середня площа 
CD34-позитивних 

судин (M±SD)

Середній пе-
риметр CD34-

позитивних судин 
(M±SD)

Чоловіки 22 (59,5) 9,00±3,89 315,42±183,79 79,59±25,45
Жінки 15 (40,5) 9,13±4,74 342,34±261,59 81,34±31,15
Р p>0,05 p>0,05 p>0,05
Вік
<49 8 (21,6) 7,00±1,77 324,61±187,73 75,56±14,66
50-75 23(62,2) 9,13±3,60 352,24±237,65 84,01±30,54
>75 6 (16,2) 11,5±6,95 229,32±150,19 72,14±29,38
Р p<0,05 p<0,05 p>0,05
Правобічні 20 (54,0) 8,65±3,63 354,54±241,44 84,40±29,65
Лівобічні 17 (46,0) 9,53±4,85 293,15±182,30 75,47±24,74
Р p>0,05 p>0,05 p>0,05
АК NOS 19 (51,4) 9,47±4,98 329,28±151,66 85,68 ±26,37
Зубчаста АК 7 (18,9) 8,57±2,99 323,54±314,98 76,36 ±33,31
Мікропапілярна 3 (8,1) 13,33±3,78 236,05±89,18 68,36 ±7,74
АК 3 (8,1) 7,33±0,57 666,82±261,11 101,95 ±32,37
Медулярна АК 2 (5,4) 6,50±0,70 155,87±3,72 53,82 ±2,94
Муцинозна АК 2 (5,4) 7,50±0,70 220,67±66,02 73,25±21,98
Перстнеподіб. АК 1 (2,7) 5,00±0,32 91,64±24,61 43,49 ±9,89
АК like-adenoma
Р p<0,05 p<0,05 p<0,05
G2 31 (83,8) 9,45±4,46 303,91±194,46 78,87±27,72
G3 6 (16,2) 7,00±1,09 442,21±297,82 87,67±27,53
P p<0,05 p<0,05 p>0,05
Без метастазів 30 (81,1) 8,80±3,41 313,47±193,97 79,18±26,25
З метастазами 7 (18,9) 10,14±6,91 313,47±193,97 85,08±34,27
P p<0,05 p>0,05 p>0,05
Ki-67 
<10 % 6 (16,2) 7,67±1,97 229,65±105,68 71,36±20,08
10-25 % 13 (35,1) 8,46±3,13 369,15±257,59 86,30±31,11
>25 % 18 (48,7) 9,94±5,24 327,65±208,89 78,94±27,24
P p<0,05 p<0,05 p>0,05

Примітка: KPK – колоректальна карцинома, АК – аденокарцинома, AK NOS – аденокарцинома не-
специфікована, M±SD – середнє±стандартне відхилення
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 3. Середній периметр CD-34-позитивних судин 
показав достовірну різницю тільки за гістологіч-
ним типом (найменший периметр судин виявилась 
в аденокарциномі типу like-аденома, найбільший 
– у мікропапілярній аденокарциномі, р<0,05).

4. Індекс проліферації за Кі-67 збільшувався ра-
зом із середньою кількістю та середньою площею 
CD-34-позитивних судин (всі р<0,05).
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